EXTRACTION OF GEOMORPHOMETRY OF PART OF KRISHNA BASIN IN SPATIAL DOMAIN

PRIYANKA R DHUMAL¹, ULKA.D.JOSHI²
1, Research scholar, 2, Assistant Professor,
Dept. of Civil EngineeringVishwakarma Institute of Information Technology,
Pune411048 (INDIA)
dhumalpriyanka17@gmail.com,ulkaj123@gmail.com

ABSTRACT

Morphology of a river basin plays primary role in the runoff generation. For a watershed, topography controls the flow of water and contaminants, records the nested 3D geometry of basins and networks, determines the amount of solar radiation received at a given location and topography is a record of past events and erosional processes and it poses a challenge to understand the physical relationship between function and form. Here in this an attempt has been endeavored to analyze the river to extract the characteristics useful for understanding geomorphology in watershed context. Digital Elevation Models makes the lengths and slopes of channel segments, the number of streams of a given order, the contributing area of a watershed, the shape of a longitudinal profile, a basin’s hypsometric curve, topographic wetness indices, the flow distance to a feature of interest and the shape of a basin. This paper illustrates the extraction of geomorphology parameters from the part of Krishna river basin (Krishna origin to Krishna confluence with Ghataprabha in Krishna River) from ASTER DEM with 30 m resolution, useful for advanced research in the domain of river management.

Keywords: Geomorphology, GIS,DEM, Hypsometry

1.0 INTRODUCTION TO RIVER CHARACTERISTICS EXTRACTION

River Characteristics Extraction from River tools with point-and-click interface that was specifically designed for working with DEMs and extracting hydrologic information from them. There is a lot of useful information that can be extracted from DEMs since topography exerts a major control on hydrologic fluxes, visibility, solar irradiation, biological communities, accessibility and many human activities. Various properties of the DEM such as its pixel geometry (fixed angle or fixed-length), number of rows and columns and bounding box can be viewed with the View DEM Info dialog in the File menu. When working with a fixed-angle DEM, the user should set the ellipsoid model to the one that was used in the creation of the original DEM data. This is done by opening the Set Preferences dialog in the File menu and selecting the Planet Info panel. A list of 51 built-in ellipsoid models for Earth can be worked out.

2.0 EXTRACTING LAND-SURFACE PARAMETERS AND OBJECTS FROM DEMS

Considering the availability of hydrological, meteorological, soil, and other collateral data, the reaches from Krishna origin to Krishna confluence with Ghataprabha in Krishna River were selected as the study area for the present flood modelling and mapping study. (Fig.1) depicts the study area. ASTER DEMs were downloaded from USGS via internet and adjacent DEM were mosaic ked together because some part of basin span across few quadrangles. Landsat ETM 30m data were downloaded to know the land use land cover pattern of this Krishna basin.
2.1 Extracting a river network

A river network can be viewed as a tree graph with its root at a particular grid cell, the outlet grid cell. The Extract→ RT Tree file dialog extracts the “drainage tree” for the watershed that drains to the outlet grid cell that you selected previously and saved. This is a raster to vector step that builds and saves the topology of the river network and also measures and saves a large number of attributes in a River-Tools vector (RTV) file with compound extension_tree.rtv. (Fig.2) depicts the river network of the area.

2.2 Extracting masks or regions of interest

Within grid layers one often wishes to restrict attention or analysis to particular regions of interest or polygons, such as watersheds, lakes, craters, or places with elevation greater than some value. For such a region, we need to know which grid cells are in the region and which are not. This is equivalent to knowing the spatial coordinates of its boundary. A large number of different attributes can be associated with any such polygon, such as its area, perimeter,
diameter (maximum distance between any two points on the boundary), average elevation, maximum flow distance or centroid coordinates.

2.3 Extracting functions

Hypsometric curves or area–altitude functions have a long history [1] [2] and River Tools can extract this and several other functions from a DEM. The width function [3] [4] and closely related area–distance function measure the fraction of a watershed (as number of links or percent area) that is at any given flow distance from the outlet (Extract → Function menu) and are tied to the instantaneous unit hydrograph concept. The cumulative area function [5] [6] measures the fraction of a watershed that has a contributing area greater than any given value. The Density Plot tool creates colour-by-number plots, and offers many different types of contrast-enhancing ‘stretches’ including linear, logarithmic, power-law and histogram equalization (Fig.3). For example, contributing area grids are best viewed with a power-law stretch, due to the fact that there are a small number of grid cells with very large values and a large number with very small values. The Contour Plot tool makes it easy to create either standard or filled contour plots (or both as a multi-layer plot) and provides a large number of options such as the ability to control the line style, width and colour of each contour line. Colour shaded relief images with different colour tables and lighting conditions can easily be created with the Shaded Relief tool (Fig. 4). There is also a tool called Shaded Aspect that simply uses D8 flow direction values with special colour tables to visualize DEM texture.

![Density Plot by Priyanka](image)

Fig.3 DENSITY PLOT

2.4 Interactive window tools

The Line Profile tool lets you click and drag in an image to draw transect and then opens another small window to display the elevation values along that transect. This new window has its own Options menu that lets you do things like save the actual profile data to a multi-column text file. The Channel Profile tool is similar (Fig.4), except that you click somewhere in the image and then the flow path or streamline from the place where you clicked to the edge of the DEM is overlaid on the image. The elevations (or optionally, the values in any other grid) along that streamline are plotted vs. distance along the streamline in another small window. Again, the Options menu of this new window has numerous entries. The Reach Info tool is similar to the Channel Profile tool but opens an additional dialog with sliders that let
you graphically select the upstream and downstream endpoints of any reach contained within the streamline and displays various attributes of that reach. If you select Vector Zoom from the Tools menu and then click in the image, crosshairs are overlaid on the image and a small window is displayed that shows grid cell boundaries, D8 flow paths and contour lines in the vicinity of where you clicked. The Value Zoom tool is similar but displays actual grid values as numbers and also shows the coordinates of the selected grid cell. This tool has many other capabilities listed in its Options menu, such as the ability to edit grids or jump to specified coordinates. Perspective, wire mesh plots are more effective when applied to smaller regions rather than to entire DEMs, so the Surface Zoom tool provides a powerful way to interactively explore a landscape. This tool has many settings at the bottom of the display window and many entries in its Options menu. The Density Zoom and Relief Zoom tools show density plots and shaded relief plots at full resolution for a selected region even though the main image may show the entire area of the DEM at a greatly reduced resolution.

2.5 Along Channel-Length

The length of a link, Strahler [1] stream, or any other channel segment as measured along the channel. This is the distance traveled by the water as it flows from one end of the channel to the other.

![Fig.4 CHANNEL PROFILE](image)

2.6 Area-Altitude Plot

From a digital point of view, this is a plot of the total area of all the pixels in a DEM that have a given elevation value, plotted against the elevation values that are present in the DEM. The same basic idea can be expressed in an analog way by imagining a contour plot for a surface, measuring the area between contours, plotting this area as a function of contour elevation, and letting the contour interval approach zero. These (or an integrated version of the same idea) are also known as hypsometric plots.
2.7 Relief

The difference between the maximum and minimum elevation values in a given geographical region, such as a basin or the region covered by a DEM. For a basin, the minimum value usually occurs at the basin outlet.

2.8 Sinuosity

Sinuosity refers to *absolute sinuosity*, which is the ratio of the along-channel length of a channel to the straight-line length of the same channel. This number can never be less than one. The straight-line length of a channel is the straight distance between the upstream and downstream endpoints of the channel.
2.9 Straight-Line Length

The length of a link, Strahler stream, or any other channel segment as measured along a straight line that connects the two endpoints of the segment. The line profile creates the X-section at a point under consideration (Fig.9).

Fig.7 LINE PROFILE

2.10 Surface area

Is a different concept and measures area on the topographic surface itself. Two basins could have the same drainage area but the one with the higher relief would tend to have a larger surface area. (Fig.10)

Fig.8 SURFACE ZOOM

2.11 Width Function Plot
This is a plot of the number of channel links in a river network or sub network (above a basin outlet), as a function of the along-channel flow distance to the basin outlet. The width function is best known for its connection to the instantaneous unit hydrograph or IUH.

**Fig.9 JUNCTION POSITION**

Plots of longitudinal elevation profiles generated from a DEM and a corresponding D8 flow grid generally show an unrealistic step-like character, with long segments of slope zero separated by abrupt steps with steep slopes. This occurs as a result of limited vertical and horizontal accuracy in the DEM, particularly for DEMs with integer-valued elevations and a vertical resolution of one meter or one foot. The essence of the problem is that slopes on streamline elevation profiles are typically very small, on the order of 0.0001 or less. However, if the vertical resolution is $\partial z$ and the horizontal resolution is $\partial x$, then the minimum, nonzero slope that is resolvable between two adjacent pixels is close to $\partial z/\partial x$. So, for example, if the vertical resolution is one meter and the horizontal resolution is 10 meters, slopes less than about 0.1 will be un-resolvable and will usually get mapped to a value of zero. Note that even for a vertical resolution of 1 centimeter; the minimum resolvable value would be 0.001, still too large to resolve the actual along-channel slope. This issue becomes a real problem in spatially-distributed hydrologic models that use DEM derived channel slope to compute flow velocity, $v$, from Manning’s formula.

### 3.0 SUMMARY REPORT OF RIVER TOOLS

Total 9 order streams were found from the analysis. The stream ratio estimates for the study area with their $R^2$ value are as under.

<table>
<thead>
<tr>
<th>Ratio</th>
<th>Slope</th>
<th>$R^2$</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.49</td>
<td>-0.652</td>
<td>0.9997</td>
<td>Stream numbers</td>
</tr>
<tr>
<td>4.43</td>
<td>0.647</td>
<td>1.0000</td>
<td>Drainage area</td>
</tr>
<tr>
<td>1.97</td>
<td>0.295</td>
<td>0.9975</td>
<td>Straight-line length</td>
</tr>
<tr>
<td>2.09</td>
<td>0.320</td>
<td>0.9990</td>
<td>Along-channel length</td>
</tr>
<tr>
<td>1.20</td>
<td>0.078</td>
<td>0.7790</td>
<td>Elevation drop</td>
</tr>
<tr>
<td>1.70</td>
<td>-0.230</td>
<td>0.9703</td>
<td>Straight-line slope</td>
</tr>
<tr>
<td>1.80</td>
<td>-0.254</td>
<td>0.9697</td>
<td>Along-channel slope</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td>--------</td>
<td>--------</td>
<td>-------------------------</td>
</tr>
<tr>
<td></td>
<td>4.41</td>
<td>0.645</td>
<td>1.0000 Total length</td>
</tr>
<tr>
<td></td>
<td>4.30</td>
<td>0.633</td>
<td>0.9998 Shreve magnitude</td>
</tr>
<tr>
<td></td>
<td>2.25</td>
<td>0.352</td>
<td>0.9973 Main channel length</td>
</tr>
<tr>
<td></td>
<td>1.77</td>
<td>0.248</td>
<td>0.9842 Relief</td>
</tr>
<tr>
<td></td>
<td>2.37</td>
<td>0.375</td>
<td>0.9969 Network diameter</td>
</tr>
<tr>
<td></td>
<td>1.04</td>
<td>0.018</td>
<td>0.9878 Sinuosity</td>
</tr>
<tr>
<td></td>
<td>1.01</td>
<td>-0.006</td>
<td>0.8929 Drainage density</td>
</tr>
<tr>
<td></td>
<td>1.08</td>
<td>-0.032</td>
<td>0.7144 Source density</td>
</tr>
<tr>
<td></td>
<td>2.14</td>
<td>0.331</td>
<td>0.9995 Links per stream</td>
</tr>
<tr>
<td></td>
<td>1.01</td>
<td>-0.006</td>
<td>0.2852 Tribs of order (w-1)</td>
</tr>
<tr>
<td></td>
<td>1.00</td>
<td>0.001</td>
<td>0.0027 Tribs of order (w-2)</td>
</tr>
<tr>
<td></td>
<td>1.29</td>
<td>0.111</td>
<td>0.7201 Tribs of order (w-3)</td>
</tr>
</tbody>
</table>

Equal-weight regression, with minimum order = 2 and maximum order = 7.

4.0 CONCLUSIONS

Topography represents different things to different people. To a hydrologist or watershed manager, topography is what controls the flow of water and contaminants, records the nested 3D geometry of basins and networks, organizes biologic communities and determines the amount of solar radiation received at a given location. To a water engineer, or geomorphologist, topography is a record of past events and erosional processes and it poses a challenge to understand the physical relationship between function and form. To urban developers, topography determines visibility and represents the surface they have to contend with. Against the aforesaid outlined texts, an honest endeavor was made for a gainful accomplishment of the geomorphology model in creating an enabling platform for accessing spatial information and technology for easy river management goal accomplishments.

5.0 REFERENCES


